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Einflihrung

WSIJT ist ein Computerprogramm zur Kommunikation fiir den VHF/UHF-Amateur, das den
aktuellen Stand der digitalen Technik nutzt. Es kann helfen, Verbindungen Uiber Reflektionen
an Meteorbahnen mit einer Lange von Sekundenbruchteilen oder mit Signalen, die weiter als
10 dB unter einem Signal liegen, mit dem eine CW-Verbindung noch méglich ist, herzustellen.

Sendearten

e FSK441 : entwickelt fir Hochgeschwindigkeitsverbindungen liber Meteorscatter
¢ JT6M : optimiert flir Meteor- und Ionospharenscatter auf 6 Meter
¢ JT65 : flir Erde-Mond-Erde (EME)-Verbindungen und schwachen Troposcatter

e CW : fir EME mit zeitgetakteter und computererzeugter Sendung

Systemanforderungen

e SSB-Transceiver und Antenne fiir ein oder mehrere VHF/UHF-Béander

e Computer mit Microsoft Windows, Linux, oder FreeBSD-Betriebssystem
e CPU mit 800 MHz oder schneller und mindestens 128 MB RAM

¢ Monitor mit mindestens 800 x 600 Pixeln (besser mehr)

e vom Betriebssystem unterstitzte Soundkarte

e PTT-Interface zwischen PC und Transceiver zur Tastung Uber eine serielle Schnittstelle.
Unter Linux und FreeBSD kann auch eine parallele Schnittstelle verwendet werden.

¢ NF(Audio)-Verbindungen zwischen PC-Soundkarte und Transceiver

e Werkzeug zur Synchronisierung der PC-Zeit mit UTC

Installation und Einstellung (Setup)

Erste Schritte

1. Windows: holen Sie sich WSJT595.EXE (oder eine neuere Version) von der Adressen
http://pulsar.princeton.edu/~joe/K1JT


http://pulsar.princeton.edu/~joe/K1JT
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oder der Quelle fiir Open-Source Programme
http://developer.berlios.de/projects/wsit/

oder von der europaischen Seite

http://www.vhfdx.de

Installieren Sie die abgeholte Datei in ein Verzeichnis Ihrer Wahl. Voreingestellt ist das
Verzeichnis C:\Program Files\WSJT6 fir das Programm WSJT.

2. Linux and FreeBSD: holen Sie sich die Installations-Dateien von der Quelle fiir Open-
Source-Programme unter
http://developer.berlios.de/projects/wsijt
Es kann eine gepackte Installation zur Verfligung stehen. Falls nicht, missen Sie das
Programm aus dem Quellencode selbst kompilieren. Sie finden Hilfe und Anweisungen
dazu unter der angegebenen Adresse.

3. Interface : Stellen Sie die bendtigten Verbindungen zwischen Transceiver und PC fur die
Audio-Signale und die PTT her. Orientieren Sie sich an den Hardware-Vorschlagen flir die
ublichen PSK31-Programme.

Hinweis DM3ML : Sie kénnen eine vorhandene Verkabelung fiir die Gblichen Digimode-
Programme ohne Anderung auch bei WSJT verwenden.

4. Programmstart : Klicken Sie doppelt auf das bei der Installation angelegte Icon WSJIT
auf dem Windows-Bildschirm. Unter Linux oder FreeBSD geben Sie
python -0 wsjt.py
am Kommando-Prompt ein.
Geoffnet werden drei zu WSIT gehdrende Fenster. Gehen Sie zum Hauptfenster mit der
Titelzeile “WSJT6 by K1JT”.

5. Options : Wahlen Sie Options im Menu Setup des Hauptfensters. Geben Sie Ihr
Rufzeichen und Ihren WW-Lokator ein. Tragen Sie unter PTT Port bei Windows die
Nummer der seriellen Schnittstelle ein, an der Ihr PTT-Interface angeschlossen ist, z.B. '1'
fir COM1. Geben Sie eine '0' (Null) ein, wenn Sie den Sender Uber die VOX steuern wollen
(wird vor allem bei héherer Sendeleistung nicht empfohlen).

Geben Sie unter Linux oder FreeBSD den Geratenamen (device name) ein z.B.

/dev/ttysSO0.

6. Verlassen Sie das Fenster Options, wahlen Sie mit der Taste F7 die Sendeart FSK441A.
Gehen Sie dann im Hauptfenster zum Men File und klicken Sie auf Open. Klicken Sie sich
zum Unterverzeichnis RxWav|Samples des WSIT-Verzeichnisses durch. Offnen Sie dort
die im QSO mit W8WN aufgezeichnete Audiodatei. Diese Datei wird von WSJT dekodiert
und liefert das auf Seite 4 zu sehende Bild. Klicken Sie mit der rechten Maustaste auf den
Ping bei t=18s im Graphikschirm und sehen Sie sich den dekodierten Text dazu an. Wenn
Sie auf das Stérungssignal bei t=1s oder eine andere Stelle der griinen Linie klicken, wird
Zufallstext dekodiert, Klicken Sie dann auf die Taste Erase (Loschen), um die Texte zu
ldschen. Wenn Sie anschliessend auf die Taste Decode (Dekodieren) klicken, wird die
gesamte Datei erneut dekodiert.

7. Achten Sie auf die beiden Zahlen unten links aussen in der Statusleiste des Hauptfensters.
Wenn WSJT eine Minute gelaufen ist, sollten sich diese Werte auf einen Wert von 1.0000


http://developer.berlios.de/projects/wsjt/
http://www.vhfdx.de/
http://developer.berlios.de/projects/wsjt/
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mit einer Toleranz zwischen 0.9995 und 1.0005 stabilisiert haben. Diese Werte zeigen an,
dass die Taktrate Ihrer Soundkarte bei 11025 Hz liegt. Liegen die angezeigten Werte fir
den Wert Rate in (erste Zahl) oder Rate out (zweite Zahl) ausserhalb der Toleranz, muss
WSIT eine Korrektur der abweichenden Taktraten vornehmen (s.u.)

8. Sie sollten auf Ihrem PC ein Programm zum Abgleich Ihrer PC-Uhr mit der genauen Weltzeit
installieren. Die Zeitabweichung sollte unter einer Sekunde liegen. Gebrauchlich sind
Programme zur Synchronisation mit GPS oder dem Internet. (DM3ML : Ich nehme die

Atomzeiteinstellung von LOGGER32).

Hauptfenster (Main Screen), Sendeart FSK441
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Optionen-Fenster (Options Screen)

— Station parameters —————————— 7 F5K441 UT6M message templates —————————  — Miscellaneous ————
Ity Caill: H1JT DHCC prefix:
{* Report " Grid f* N& { EU

Grid Locator:  [Fr20i - Source RA:
ID rterval (m): (10 Reset defaults | Source DEC:

PTT Port: 1
| Tx 1 [T %M
Avdio In: 0

Tx 2 [%T %R %M %R%R

Avcho Out: 0 Tx % IR%H
Rate Inc 10 T4 IRF:F!
Rate Cut: 1.0 Te & |?3

Digtanceunt: * mi km Tx 6 |CG) ol

Hardwarestatus (Control Screen)

' WSJT6 =

WSJT Uersion 5.9.7 »383 . by KiJT

Revizion date: 28@7-85-84 B9:17:52 #4880 (Fri,. B4 May 2687>
Run date: Sat Jun @7 B?:45:81 28087 UTC

Uzing PortAudio.

Audio Input Output Device Hame
Device Channels Channels

Microsoft Soundmapper — Input
Realtek HD Audio Input

USE Audio CODEC

Hicrosoft Soundmapper — Output
Realtek HD Audio output

USE Audio CODEC

Default Input: 8 Qutput: 3
Requested Input: 2 Output: &

Opening device 2 for input, 5 for output.
Audio streams running normally.

(Kopie des Fensters bei DM3ML : USB Audio Codec = microHam Digikeyer)

NF-Pegel einstellen

1. Hat Thr PC mehr als eine Soundkarte, mussen Sie deren Nummer im Fenster Options unter
Audio In und Audio Out eintragen. Sie sehen im Konsolen-Fenster (Console Window)
auf der Seite 17 eine Tabelle mit den méglichen Werten.
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2. Schalten Sie Ihren Transceiver ein und stellen Sie ihn auf eine ruhige Frequenz, so dass nur
das Grundrauschen an die Soundkarte geliefert wird.

3. Klicken Sie auf die Taste Monitor. Die Taste wird griin und die Auswertung beginnt.

4. Gehen Sie zum SpecJT-Fenster und wahlen Sie im Menli Options den Punkt Rx volume
control. Der Windows-Soundkartenmixer mit seinen Schiebereglern wird gedffnet.

5. Stellen Sie mit dem Schieberegler oder dem NF-Regler Ihres Transceivers die NF-Amplitude
so ein, dass im Feld unten rechts des SpecJT-Fensters ein Pegel von 0 dB angezeigt wird.
Der gleiche Wert wird in der Statusleiste des WSJT-Hauptfensters angezeigt.

6. Driicken Sie die Taste F7 um zur Sendeart FSK441A zu kommen.

7. Wahlen Sie jetzt Options | Tx volume control , um mit dem Soundkartenmixer den
Sendepegel einzustellen.

8. Klicken Sie auf die Taste Tx1 rechts unten im Hauptfenster. Ist Ihre PTT richtig eingestellt
und die Soundkarte angeschlossen, wird Ihr Transceiver auf Senden geschaltet und mit
dem Soundkartensignal moduliert. Hinweis DM3ML : Tcvr auf USB schalten.

9. Stellen Sie den Schieberegler des Soundkartenmixers so ein, dass der Transceiver
ausreichend moduliert wird. Hinweis DM3ML : Die ALC sollte gerade anfangen
anzusprechen.

Anforderungen an die Endstufe

WSIJT erzeugt Signale mit jeweils einer NF-Frequenz und konstanter Amplitude . Die
Umtastung des Signals von einer Frequenz auf die andere erfolgt phasenkontinuierlich. Mit
Ausnahme der Tastung des Rufzeichens zur Signalidentifikation wird keine Hochtastzeit
bendtigt. WSIT bendtigt daher keine hohe Linearitat der Endstufe. Sie kdnnen eine Endstufe
im C-Betrieb verwenden, ohne dass Nebenlinien und Splatter erzeugt werden. Die Sendungen
mit einer Dauer von 30 bzw. 60 Sekunden mit voller Amplitude belasten Ihre Gerate nattirlich
starker als Sendungen in CW oder SSB. Wird Ihre Endstufe dabei zu warm, reduzieren Sie die
Sendeleistung oder halten Sie einen zusatzlichen Lufter bereit.

Mit den obenstehenden Einstellungen ist WSIT fiir den Funkbetrieb bereit. Beachten Sie aber,
dass WSJT ein kompliziertes Programm ist. Sie haben zahlreiche Mdglichkeiten eine korrekte
Dekodierung des empfangenen Signals zu steuern. Sie sollten als WSJT-Neuling den
nachstehenden Dekodierkurs aufmerksam und intensiv durcharbeiten.

Schritt fur Schritt - Dekodierkurs

Einen wesentlichen Anteil an der effektiven Nutzung der Mdglichkeiten des Programm WSJT
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hat die Kenntnis der verschiedenen Dekodiermdglichkeiten, die im folgenden Kurs dargestellt
werden. Fir diesen Kurs mussen Sie sich ein Paket mit Audio-Dateien von diesen Adressen
abholen :

http://pulsar.princeton.edu/~joe/K1JT/WSJIT6 Samples.EXE (Windows) oder
http://pulsar.princeton.edu/~joe/K1JT/WSJT6_Samples.tgz (Linux).

Diese Dateien enthalten unter realen Bedingungen aufgenommene Pings flir FSK441, Pings
und Iono-Scattersignale flir JT6M und EME-Signale fir JT65. Das ganze Paket umfasst 22 MB.
Sollten Sie keine schnelle Internetverbindung haben, finden Sie unter
http://pulsar.princeton.edu/~joe/K1JT/Download.htm eine Bezugsmdglichkeit fiir eine CD-
ROM.

1. Haben Sie WSJT6 bereits installiert und verwendet, setzten Sie Ihre Datei WSJT.INI
voriibergehend ausser Kraft, in dem Sie sie umbenennen oder aus dem WSJT-
Verzeichnis herausnehmen und sichern. Sie erreichen damit, dass WSJT mit einer
voreingestellten Konfiguration gestartet wird.

2. Installieren Sie die Beispieldateien im Unterverzeichnis RxWav des WSJT6-
Installationsverzeichnisses. Wenn Sie die abgeholte Datei WSJT6_Samples.EXE (in
Windows) starten oder die TAR-Datei WSJT6_Samples.tgz (in Linux oder FreeBSD)
extrahieren, werden die Beispieldateien am angegebenen Ort gespeichert.

3. Starten Sie WSJT6 unter Windows mit einem Doppelklick auf das Icon auf dem Desktop
oder geben Sie unter Linux das Kommando python -0 wsjt.py ein . Schieben Sie die
WSJT6-Fenster in eine bedienbare Lage auf Ihrem Bildschirm. Wichtig ist das
Hauptfenster, die beiden anderen Fenster (Spec]T und Control) kdnnen Sie minimieren.

4. Voreingestellt startet WSJT mit der Sendeart FSK441 (gelbe Marke unten links in der
Statusleiste). Gehen Sie zum Meni File > Open und 6ffnen Sie das Unterverzeichnis
RxWav|Samples | FSK441 unter dem WSJT-Hauptverzeichnis. Klicken Sie doppelt
auf die Datei K5CZD _050723_134100.WAYV. Die Datei wird gedffnet und im Grafik-
Bereich des Hauptfensters erscheint ein zweidimensionales Spektrogramm. Der
Dekoder wertet das Spektrogramm aus und im Textbereich des Hauptfensters erscheint
diese Ausgabe :

134100 27.4 220 6 26 -21 01JT 26 K5CZD 2626 K1JT 27 K5CZ #6

Die erste Angabe ist die Startzeit des Spektrogramms um 13:41:00 z. Dann folgt die
Startzeit des Meteor-Pings bezogen auf diese Marke um t = 27.4 s. Der Ping dauerte
220 ms und hatte einen Stérabstand (S+N)/N = 6 dB. Der im Ping enthaltene Text
zeigt, dass K5CZD and K1JT den MS-Rapport ,26" gibt. Am Anfang und am Ende des
Pings erscheinen bei FSK441 und JT6M in der Regel falsche Zeichen, da dort der Ping
aus dem Rauschen kommt oder ins Rauschen verschwindet. Weiter unten finden Sie
erganzende Information zur Struktur der Nachrichten und tGbermittelten Informationen.

5. Drilcken Sie die Taste F6 oder wahlen Sie im Menil File > Open next in directory,
um die nachsten Dateien im FSK441-Verzeichnis zu 6ffnen. Die Dateien enthalten


http://pulsar.princeton.edu/~joe/K1JT/Download.htm
http://pulsar.princeton.edu/~joe/K1JT/WSJT6_Samples.tgz 
http://pulsar.princeton.edu/~joe/K1JT/WSJT6_Samples.EXE 
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Aufzeichnungen zu K8EB ruft KB4BWW, KCOHLN ruft CQ und arbeitet dann K1]T,
KM5ES arbeitet K1JT, KM5PO ruft K1JT als “tailender™ und schliesslich ruft N9EGT CQ.
Versuchen Sie, in den Dateien mit der linken und rechten Maustaste auf die Pings zu
klicken, um den Dekoder zur Bearbeitung der jeweiligen Signale zu veranlassen. Sie
kdnnen auch einmal ins reine Rauschen klicken und reinen Zufallstext erzeugen.
Klicken Sie nach einem Versuch auf die Tasten Erase oder Decode um den erzeugten
Text im Fenster wieder zu léschen und starten Sie den nachsten Versuch.

6. Offnen Sie die Datei mit KCOHLN noch einmal. Sie erzeugt diese Mitteilung :
001400 6.5 400 15 27 -21 2 CQ KCOHLN EN32 CQ KCOHLN E/31 GQ#GBYLE

Klicken Sie doppelt auf das Rufzeichen KCOHLN im Textbereich und verfolgen Sie, was
in dem Fenster der zu sendenden Texte passiert. Das Programm ist nun bereit fur K1JT
um den CQ-Ruf zu beantworten.

7. Schalten Sie mit Shift-F7 auf de Sendeart JT6M um. Unter LINUX muissen Sie in das
Menl Mode gehen. Wahlen Sie mit dem Menl File > Open aus dem Verzeichnis
RxWav\Samples\JT6M jetzt eine JT6M-Aufnahme aus und klicken Sie auf die Datei
AASMY . Sie sehen, dass AASMY mit “73 DE AA9MY” ein QSO beendet :

142300 15.1 1.2 -2 -15 9MY 73 DE AA9MF2

Das Signal von AASMY st ein Stick leiser als die FSK441-Beispiele. Horen Sie sich
Dateien mit einem Windows-Programm Uber Lautsprecher oder Kopfhérer an, um ein
Gefihl fur diese Art der Signale zu bekommen.

8. Schalten Sie mit F6 die Dateien des JT6M-Verzeichnisses durch. Sie sehen AC5TM mit
K1SIX arbeiten, AF40 arbeitet K1JT und WA5UFH arbeitet KOAWU. In verschiedenen
Dateien sind die Signale unhérbar oder kaum hérbar, aber dekodierbar. Die zweite
AF40-Datei erzeugt in der Voreinstellung keinen dekodierter Text, aber versuchen Sie
es mit einem Rechtsklick bei etwa t = 16.6 s. Die zu diesem Punkt gehdrende Zeit wird
in einer griinen Marke unten links im Diagrammfenster angezeigt. Sie kdnnen solche
Bereiche mit dekodierbarem Text in den verschiedenen Beispielen im flachen Bereich
der griinen Kurve finden. Klicken Sie zum Beispiel links auf t = 7.4 sodert = 9.8 sin
der ersten AF40-Datei oder auf t = 11.6 s in der zweiten AF40-Datei.

9. Schalten Sie mit F8 auf die Sendeart JT65A und entfernen den Haken aus dem Feld
Freeze (Einfrieren). Beachten Sie sowohl das SpecJT-Fenster als auch das
Hauptfenster. Haben Sie das Fenster vorher minimiert, wahlen Sie im Meni View >
Spec]T, um es zu 6ffnen. Falls sich beide Fenster Uberlappen, reduzieren Sie die
vertikale GroBe des SpecJT-Fensters, so dass nur der obere Teil angezeigt wird.
Wahlen Sie die Geschwindigkeit 3 und aktivieren Sie im Options-Meni des SpeccIT-
Fensters die Punkte : Mark T/R boundaries, Flatten spectra, Mark JT65 tones
only if Freeze is checked und JT65 DF axis. Gehen Sie im Hauptfenster das Menu
File > Open und gehen Sie in das JT65A-Verzeichnis. Machen Sie einen Doppelklick
auf die Datei FOHS. Der Spec]T-Schirm zeigt ein chaotisches Spektrum mit
Stérsignalen in 100 Hz —Intervallen und andere Stérsignale, aber im Display des
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Hauptfensters sehen Sie in der roten Kurve eine scharfe Spitze, die einen JT65-
Synchronton anzeigt. Der Dekoder produziert

074800 1 -23 2.7 363 5 * K1JT FOHS JN23 1 10

10.Klicken Sie doppelt auf das Rufzeichen FOHS im Textfenster. FOHS wird in das Feld To

11.

Radio tibernommen. In der Datenbank wird nach dem Lokator von FOHS gesucht.
Wurde er gefunden, wird er in das Feld Grid eingetragen. Die unter Options mit
Macros vorbereiteten Tx messages werden mit dem Rufzeichen FOHS flir ein QSO
vorbereitet, der Zeiger wird auf die Nachricht Tx2 gesetzt, mit der der Signalrapport an
FOHS gesendet wird. Sie kbnnen diese Vorbereitungen in der Zeit zwischem dem Ende
der Sendeperiode von FOHS (DM3ML : sie endet etwa bei Sekunde 48) und dem Beginn
Ihrer Sendeperiode bei der Sekunde 00 der nachsten Minute treffen.

Mit F6 offnen Sie das nachste Beispiel. Die Nadel in der roten Kurve ist schmaler und
Sie sehen, dass G3FPQ W7GJ anruft :

1319001 -251.542 3 * W7G]J G3FPQ 109110

12.Mit Shift-F8 schalten Sie auf die Sendeart JT65B um. Unter Linux missen dazu Sie

ins Meni Mode gehen. Gehen Sie mit File > Open zu den JT65B-Beispielen und
offnen Sie die Datei mit DL7UAE. Im Wasserfall sehen Sie ein starkes Birdie bei DF =
783 Hz und eine Reihe schwacherer Signale. Die Signale bei DF = 223 und DF = 244
Hz sehen interessant aus, weil sie das EME-typische gesprenkelte QSB zeigen, das
durch die EME-Libration auf 2m hervorgerufen wird. WSJT wahlt das Signal bei DF =
223 Hz als das vielversprechendste und dekodiert einen Anruf von DL7UAE nach einem
CQ von K1JT :

002400 6 -23 2.5 223 23 * K1JT DL7UAE J0621 10

Die rote Kurve zeigt eine zweite Spitze, die so gut wie das DL7UAE-Signal aussieht
Versuchen Sie herauszubekommen, wer da noch anruft. Eine Lésung finden Sie im
Schritt 19.

Hinweis DM3ML : DF gibt die Frequenzabweichung von der Skalenmitte an. +DF-Werte
liegen oberhalb (rechts) und —DF-Werte unterhalb (links) von der Mitte.

13.Wenn Sie bereit sind fortzufahren, I6schen Sie die Haken in den Feldern Freeze und

AFC, |6schen Sie die beiden Textfenster mit Erase und Clr Avg und driicken Sie dann
F6 , um die nachste Beispieldatei zu 6ffnen. Die griine Kurve zeigt unangenehmes SSB-
QRM ab t = 5.3 s. Sie sollten sich die Datei einmal anhdren. Zusatzlich ist rythmisches
Breitbandrauschen zu héren, wie man an der griinen Linie sehen kann.
Glucklicherweise ist der Wasserfall um die wichtige JT65-Region herum ziemlich sauber
und WSJT hat kein Problem, das Signal bei DF = -46 Hz zu dekodieren. EA5SE sendet
an K1JT einen OOO-Rapport :

000400 2 -25 2.9 -46 3 # K1JT EA5SE IM98 000 1 10

Klicken Sie jetzt doppelt auf den Synchronton im Wasserfall (DM3ML : die
durchlaufende Linie links im JT65-Signal) oder auf die Spitze in der roten Kurve im
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Hauptfenster, Beide Aktionen bewirken das Gleiche : DF wird auf die Signalablage
gestellt, Freeze (Einfrieren) wird aktiviert , der Abtastbereich wird auf Tol = 50 Hz
gesetzt und der Dekoder wird gestartet. Sie sehen im Wasserfall, dass der Suchbereich
fur den Synchronton auf einen Bereich von +/- 50Hz um die Frequenzlage DF=-46 Hz
herum reduziert.

Beachten Sie die Frequenzmarken oben im Wasserfall in der Frequenzskala. Die am
weitesten links stehende griine Marke zeigt die gewahlte eingefrorene DF (Freeze DF)
an. Der horizontale griine Bereich markiert den Bereich, in dem nach einem
Synchronton gesucht wird. Die anderen griinen Linien geben den oberen Bereich der
JT65-Datentdne an, die roten Marken stehen auf den Toénen, die bei den
Kurzmeldungen (Shorthand messages) verwendet werden..

14. Dricken Sie auf F6 flr das nachste Beispiel. EASSE sendet an K1JT die Kurzmeldung
RRR. Die violette und die orangene Kurve im Display des Hauptfensters zeigen das
gemessene Spektrum fiir die beiden Phasen der Kurzmeldung .Im Wasserfall sehen Sie
die beiden Linien der Téne der Kurzmeldung RRR akkurat abgeglichen mit den roten
Marken und dem Synchronton. Wenn Sie F6 noch einmal drlicken, sehen Sie, wie
EASSE das abschlieBende 73 an K1JT sendet

15.Ldschen Sie den Haken bei Freeze wieder und drlicken Sie noch einmal F6. Im
Wasserfall ist ein schwacher Synchronton mit tiefem Librationsfading bei DF = -22 Hz
zu sehen und der Dekoder meldet EI4DQ, der an K1JT einen OOO-Rapport sendet.
Klicken Sie doppelt auf den Synchronton, um ihn einzufangen, und gehen Sie dann mit
F6, um die nachste Datei zu 6ffnen. Hier hat EI4DQ offensichtlich den OOO-Rapport
von K1JT empfangen und sendet RO.

16.L6schen Sie das Freeze-Feld wieder, aktivieren Sie die AFC und driicken Sie auf F6 ,
um die nachste Datei zu 6ffnen. Zwei Stérsignale sind im Passband zu sehen, aber
WSIJT ignoriert sie und findet einen gliltigen Synchronton bei DF = 223 Hz. Es
dekodiert IKIUWL, der einen O00-Rapport an K1JT senden. Schalten Sie die AFC
probeweise ab und klicken Sie auf Decode. Sie sehen, dass sich die erste der zwei
Ziffern am rechten Ende der Dekodierzeile von 1 auf 0 dndert. Damit wird angezeigt,
dass ohne die AFC der Deep Search decoder zur Dekodierung benétigt wird. Klicken
Sie doppelt auf den Synchronton, um auf IKIUWL einzurasten und warten Sie auf den
nachsten Durchgang, den sie mit F6 aufrufen. IKIUWL hat das RO von K1JT
aufgenommen und sendet jetzt RRR. Diese Kurzmeldung ist im Wasserfall kaum zu
sehen, wird aber von WSJT korrekt dekodiert. K1JT sendet zum Abschluss 73 und das
QSO ist erfolgreich zuende.

17.L6schen Sie Freeze und AFC wieder und driicken Sie F6. RU1AA ruft CQ und hat ein
dickes Signal, seine Téne sind deutlich zu héren. In den nachsten Dateien arbeitet K1JT
ihn schnell, nur zwei Storsignale driften durch das JT65-PaBband. Bitte beachten Sie,
dass Kurzmeldungen solange mit einem ,?’ gekennzeichnet werden, so lange Sie nicht
Freeze eingeschaltet und die Toleranz) auf 100 Hz oder weniger gesetzt haben. Sie
sollten diese Funktionen aber immer aktivieren, um beste Ergebnisse zu erzielen.
Hinweis DM3ML : Sie werden mit einem Doppelklick auf einen Synchronton
automatisch eingeschaltet.
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RU1AA beendet das QSO mit einem
TNX JOE -14 73

und teilt damit K1JT mit, dass sein Signal bei -14 dB lag. Wenn eine Nachricht nicht mit
beiden Rufzeichen oder einem CQ oder QRZ plus ein Rufzeichen beginnt, wird sie als
einfacher Text behandelt. Eine Nachricht dieser Art darf héchstens 13 Zeichen
enthalten. Im vorliegenden Beispiel wird die ,3" von ,73" abgeschnitten (da der Text 14
Zeichen lang ist).

18.Ldschen Sie Freeze wieder und drlicken Sie auf F6, um zu einem weiteren dicken
russischen Signal zu kommen : RW1AY/1 antwortet auf das CQ von K1JT. Klicken Sie
doppelt auf den Synchronton, entweder im Wasserfall oder die rote Spitze im
Hauptfenster, um das Signal einzurasten. Gehen Sie mit F6 weiter und sehen Sie die
weiteren drei Dateien mit “"RO”, 73" und “-19TNXQSO 73" an.

19.Haben Sie herausbekommen, wer die zweite Station war, die auf mein CQ in der
DL7UAE-Datei geantwortet hat ? Wenn ja : Gratuliere ! Wenn nicht, 16schen Sie
Freeze und gehen Sie zurlick zu File > Open und 6ffnen Sie die Datei noch einmal.
Klicken Sie links auf die kleinere rote Nadel, schalten Sie Freeze ein und verkleinern
Sie die Tol auf 10 Hz. Klicken Sie dann auf Decode und Sie werden sehen, dass
SP6GWB K1JT mit einem exzellenten Signal anruft. Die Signale von DL7UAE und
SP6GWB sind nur 22 Hz auseinander und die meisten Téne Uberlappen sich im 355 Hz
breiten Passband von JT65B. Trotzdem halt der Dekoder sie bei dem QRM dank seinem
robusten Fehlerkorrekturkode perfekt auseinander.

20. Wahrend Sie die Datei von DL7UAE noch im Speicher haben, Freeze auf Ein, Tol =
10 Hz und DF auf die schmalere Nadel gesetzt ist, rufen Sie mit F2 das Menii Setup
> Options auf und tragen Sie Ihr eigenes Rufzeichen anstelle von K1JT in das Feld My
Call ein. Verlassen Sie dann das Options-Fenster und versuchen Sie erneut, das Signal
von SP6GWB zu dekodieren. Sie werden sehen, dass dieser Versuch fehlschlagt, denn
die Dekodierung wurde mit dem Deep Search decoder vorgenommen, der weiter
untern beschrieben wird.

Der Schritt-fir-Schritt-Dekodierkurs ist damit beendet.

Arbeiten mit WSJT

Im Laufe der langen Tradition des Funkens (iber Meteorscatterbahnen, Giber Ionoscatter und
Uber den Mond haben sich Regeln fiir den Mindestdatenaustausch bei einem QSO
herausgebildet, die von allen Teilnehmern eingehalten werden sollten. WSJT ist fiir diesen
Informationsaustausch unter schwierigen Bedingungen entworfen worden und die Einhaltung
der Regeln von allen Beteiligten macht es einfacher, ein einwandfreies QSO Uber die Biihne zu
bekommen.

(Hinweis DM3ML : Werden die Regeln nicht eingehalten, kann ein QSO trotz aller Mihe nicht
anerkannt werden und wird als NC (not completed) gewertet.
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Diese Minimalregeln sind einzuhalten :

1. Solange Sie nicht beide Rufzeichen von der Gegenstation komplett empfangen
haben, senden Sie beide Rufzeichen.

2. Haben Sie beide Rufzeichen von der Gegenstation empfangen, senden Sie beide
Rufzeichen und den Signalrapport.

3. Haben Sie beide Rufzeichen und den Rapport von der Gegenstation empfangen,
senden Sie ein R plus den Signalrapport. (Hinweis DM3ML : Bleiben Sie bei dem
zuerst gesendeten Rapport, auch wenn er sich im Laufe des QSOs andert)

4. Haben Sie von der Gegenstation das R plus Signalrapport empfangen, senden Sie
RRR.

5. Haben Sie von der Gegenstation das RRR empfangen, ist das QSO “offiziell”
komplett. Sie kdnnen sich aber nicht sicher sein, dass die Gegenstation der gleichen
Meinung ist. Ublich ist es, ganz zum Schluss mindestens ein freundliches 73 zu
senden, um ganz sicher zu sein, dass alles OK ist.

In den verschiedenen Teilen der Welt kann es leicht unterschiedliche Prozeduren geben
(Hinweis DM3ML : Sie wurden aber von der IARU weltweit vorgegeben). Wenn Sie auf die
Taste F5 dricken, 6ffnet WSJT ein Fenster, dass Sie an diese Prozeduren erinnert.

Zur Vorbereitung eins QSOs tragen Sie das Rufzeichen der Gegenstation ins das Feld To radio
ein, sehen Sie mit einem Klick auf Lookup nach, ob der Lokator der Station schon in der
Datenbank steht und erzeugen Sie mit einem Klick auf die Taste GenStdMsgs die fiir das
QSO bendtigten Nachrichten. Finden Sie mit Lookup das Rufzeichen in der Datei CALL3.TXT
nicht, tragen Sie den Lokator von Hand ein. (DM3ML : WSJT rechnet Antennenrichtung und
Entfernung aus). Legen Sie fest, ob Sie oder die Gegenstation zur geraden Minute mit dem
Senden startet, indem Sie einen Haken in das Feld Tx First machen oder den Haken
entfernen (Hinweis DM3ML : Haben Sie den CQ-Ruf der Gegenstation in einer ungeraden
Minute bzw. der zweiten Minutenhalfte empfangen, machen Sie einen Haken in TX First .
Entfernen Sie den Haken, wenn die Gegenstation ihren CQ-Ruf in der geraden Minute oder in
den ersten 30 Sekunden der Minute gesendet hat). Klicken Sie auf die Taste mit dem kleinen
Kreis, die zu dem TX n —Feld gehort, dass Sie als nachstes senden wollen. (DM3ML: beim
ersten Anruf ist es das Feld Tx2). Schalten Sie das Senden im Zeitraster mit einem Klick auf
die Taste Auto ein. Sie kdnnen den gesendeten Text wahrend Ihrer Sendeperiode mit einem
Klick auf die gewiinschte Tx-Taste wechseln (Hinweis DM3ML : Mit einem Klick auf eine Tx-
Taste wird das Senden unmittelbar gestartet, wenn die Taste Auto nicht aktiviert ist.
Unbeabsichtigtes Senden kann mit einem Klick auf die Taste Tx Stop abgebrochen werden.
Das Echtzeit-Spektrogramm wird auf dem SpecJT-Schirm grafisch ausgegeben. Die
Spektrogramme (Wasserfall) laufen bei FSK441 und JT6M horizontal von links nach rechts
und bei JT65 vertikal von oben nach unten. Oben rechts im Spec]T-Fenster kbnnen Sie die
Durchlaufgeschwindigkeit wahlen (DM3ML : Standard ist ,3").

Am Ende jeder Empfangsperiode wertet WSJT das empfangene Signal aus und zeigt seine
Ergebnisse im Hauptfenster an. Ein Beispiel flir JT6M sehen Sie auf der nachsten Seite,
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Beispiele fiir FSK441 und JT65 sehen Sie auf den Seiten 4 und 14. Die griine Linie im
Diagramm zeigt die Signalstarke Uber der Zeit an, die anderen Linien oder Bilder geben die
Spektralinformation und die Ergebnisse der Synchronisation abhangig von der gewahlten
Sendeart wieder.

Der dekodierte Text erscheint im Textfenster unterhalb des grafischen Bereichs und wird an
die Sammeldatei ALL.TXT geschickt. In jeder Textzeile wird die vom Programm optimierte
Frequenzablage DF relativ zur Skalenmitte angegeben. Die Genauigkeit dieser Ablage liegt bei
+25 Hz flir FSK441-Signale, +£10 Hz fir JT6M und +3 Hz fir JT65. Sie sollten diese
Ubereinstimmenden Angaben zu DF in Abhdngigkeit von der Stabilitat der Oszillatoren in
nahezu gleicher GroBe flr die dekodierten Texte bei auswertbaren Signalen untereinander
sehen.

Wenn Sie doppelt auf ein Rufzeichen im Textfenster klicken, wird dieses Rufzeichen in das
Feld To radio kopiert. In der Datenbank wird nach dem zugehdrigen Lokator gesucht. Wird er
gefunden, wird er in das Lokatorfeld eingetragen, Das angeklickte Rufzeichen wird in die
vorbereiteten Nachrichten Tx1 und Tx2 eingetragen. Wird im dekodierten Text ein CQ
gefunden, wird automatisch die die Nachricht Tx1 als nachste zu sendende Nachricht aktiviert.
Anderen Falls wird die Nachricht Tx2 ausgewahlt (Anruf durch die Gegenstation). Der Status
Tx First wird in Abhangigkeit von der Zeitlage der empfangenen Nachricht gesetzt oder -
wenn die Option “"Double-click on callsignh sets TxFirst” (Doppelklick auf ein
Rufzeichen schaltet TXFirst ein) im Setup-Meni aktiviert wurde — auf Ein geschaltet.

Sendearten

FSK441 und JT6M

Die Sendearten FSK441 und JT6M arbeiten mit 30s-Perioden flir Senden und Empfang.
Wahrend der Empfangsintervalle sucht das Programm nach kurzlebigen Signalen, die bei
Reflektionen an Meteorbahnen entstehen. Sie kdnnen diese Pings héren und sehen Sie als
Spitzen auf der griinen Linie und als hellere Bereiche im Wasserfall.

JT6M Mode

% WSJT6 byK1JT
File Setup View Mode Decode Save Band Help

8.2 Time (=) AL9MY 030323 142300
FilelD T ‘Width dB DF Freq (kHz)

|1z123m 15.1 1.2 -2 -15§ aMY 73 DE AAGHM -]
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Eine oder mehrere Zeilen von Text werden mit jedem Ping erzeugt. Wenn Sie in den
grafischen Bereich klicken, kdnnen Sie die Dekodierung eines Pings ausldsen. Sie kénnen
auch, wenn Sie einen Ping gehoért haben, auf diese Stelle im SpecJT-Display klicken, um den
Ping unmittelbar zu dekodieren.

WSJT bemiiht sich die Ablage zwischen Sende- und Empfangssignal zu kompensieren. Es
sucht bei FSK441 und JT6M in einem Bereich von + 400 Hz um die Skalenmitte nach
dekodierbaren Signalen. Sie kénnen diesen Bereich mit der Einstellung der Tol(eranz)
verringern. Mit einem Rechts- oder Linksklick kénnen Sie die Parameter zu jeder Zeit
verandern. S setzt die minimale Signalstarke in dB lber der ein Ping akzeptiert wird. Clip setzt
einen Parameter, der die Immunitat des Programms gegen Breitbandstdrimpulse festlegt.
Setzen Sie Clip auf einen Wert gréBer als Null, wenn z.B. statische Entladungen zu viel
Textmdill erzeugen. Alle Parameter kdnnen mit der Taste Defaults auf ihre voreingestellten
Werte zurlick gesetzt werden.

Liegt bei FSK441 und JT6M der Wert fir DF ausserhalb des Bereichs von £ 100 Hz, sollten
Sie Empfangerabstimmung korrigieren. Verwenden Sie die RIT-Regelung oder verwenden Sie
getrennte VFOs fir TX und RX. Bei JT6M kdnnen Sie Freeze aktivieren und mit den Tasten
Freeze DF unten in der Statusleiste den gewiinschten Wert fiir DF einstellen. Lassen Sie ihre
Sendefrequenz auf jeden Fall unverandert, denn Ihr Partner optimiert das empfangene Signal
in gleicher Weise.

Die griine Linie zeigt bei_JT6M den Gesamtsignalpegel an, die gelbe Linie zeigt die dekodierte
Starke des JT6M-Synchrontons . JT6M versucht, sowohl die einzelnen Pings als auch die
gesamte Empfangsperiode oder Teile davon zu einer ,Summennachricht" (average message)
zusammenzufassen. Eine Summennachricht wird mit einem Stern auf der rechten Seite der
dekodierten Nachricht markiert. Ein Klick mit der linken Maustaste dekodiert einen 4s langen
Bereich in der Nahe des Mauszeigers, ein Klick mit der rechten Maustaste dekodiert 10s.

Wie bei FSK441 kdnnen Sie bei JT6M innerhalb eines Signals mit den verschiedenen
Mdglichkeiten zur besten Dekodierung experimentieren. JT6M kann Signale dekodieren, die
mehrere dB schwacher sein kdnnen als die bei FSK441 bendtigten Signalstarken. Sie werden
sehen, dass ein Klick auf die flache griine Linie, wo nichts von einem Signal zu sehen ist und
zu héren war, ein Rufzeichen oder eine andere Information aus dem Rauschen zu Tage bringt.
Die Standard-Meldungen werden in FSK441 und JT6M mit der Hilfe von Vorlagen gebildet, die
Sie unter Setup > Options sehen und editieren kénnen. Die voreingestellten Vorlagen
entsprechen den Betriebstechniken in Nordamerika und Europa. Sie kénnen Sie Ihren
Wiinschen anpassen. Die Anderungen werden gespeichert und stehen beim
Programmneustart von WSJT wieder zur Verfligung. Die Texte fiir FSK441 und JT6M kdnnen
maximal 28 Zeichen enthalten. Erlaubt sind diese Zeichen :

0123456789ABCDEFGHIJKLMNOPQRSTUVWXYZ.,/#?$unddas
Leerzeichen (Zwischenraum).

Bei FSK441 kdnnen Sie spezielle Kurzmeldungen mit héherer Effektivitdt senden, wenn Sie die
Option Sh Msg freigeben. Diese Kurzmeldungen (shorthands) stehen bereit :

R26, R27, RRR und 73

FSK441 sendet flr diese Kurzmeldungen die Téne 882, 1323, 1764 oder 2205 Hz. Die
Kurzmeldungen sollten nicht verwendet werden, wenn eine hohe Aktivitat z.B. bei
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Meteoritenschauern herrscht und andere Signale als das der eigenen Gegenstation zu
Irrtimern flhren kénnen. Die Daten sollten dann als normaler Text gesendet werden und mit
einem Rufzeichen oder einem Teil davon erganzt werden.

Ein typisches Minimal-QSO in FSK441 oder JT6M kann so aussehen :

. CQKLIT

«  K1JT WSWN
«  W8SWN K1JT 27

. JTR26
« WN RRR

.« 73 WSWN

Gehen Sie in diesem Schema nur dann vorwarts, wenn Sie die bendétigte Information des QSO-
Partners zweifelsfrei empfangen haben !!

JT65

JT65 hat drei Untersendearten : JT65A, B und C. Sie sind weitgehend identisch und
unterscheiden sich in den gesendeten Tonintervallen. Im Anhang A stehen dazu die
Einzelheiten. Im Moment wird JT65A auf 50 MHz, JT65B auf 144 und 432 MHz und JT65C auf
1296 MHz verwendet. Die Modi B und C sind geringfligig unempfindlicher als Mode A , aber
toleranter gegen Frequenzdrift und gegen Flatterfading.

JT65 verwendet 60s lange Intervalle fir Senden und Empfang. Ein empfangenes Signal wird
erst dann analysiert, wenn die Empfangsperiode (ca. 47 s lang) komplett ist. Wie auf dem
folgenden Bild zu sehen ist, sehen Sie im Grafikdisplay rote und blaue Linien entlang der
grunen Linie. Die rote Linie zeigt die Versuche des Programms auf ein Signal zu
synchronisieren und die blaue die Synchronisation Uiber der Zeit. Beide Linien werden zur
Dekodierung des Signals benétigt. Sie kdnnen die untere Schwelle zur Synchronisation mit
dem Parameter Sync einstellen (voreingestellt ist 1). Die erfolgreiche Synchronisation wird
durch eine spitze Nadel in der roten Kurve und eine breitere Spitze in der blauen Kurve
angezeigt. Die Lage dieser Maxima korrespondiert mit dem Zeit- und dem Frequenzversatz
(DT und DF) gegenliber dem Signal der Gegenstation. Bei EME betrdgt der Zeitversatz 2,5s
und das Signal kann einen signifikanten Dopplerversatz haben. Zusammen mit den
Frequenzabweichungen und Fehlern der Uhr ergeben diese Effekte die angezeigten Werte fiir
DT und DF.

JT65 ist tolerant gegentiber Frequenzabweichungen bis zu £600 Hz. Sie brauchen die RIT
Ihres Empfangers nur dann zu verstellen, wenn die rote Synchronnadel links oder rechts
aussen im Display steht. Auf Bandern oberhalb von 432 MHz, auf denen die
Dopplerverschiebung mehrere kHz betragen kann, sollten Sie ein RIT mit einem gréBeren
Bereich oder einen getrennten RX-VFO verwenden, um das gewiinschte Signal finden zu
kdnnen. Hat das Programm einmal die Gegenstation gefunden, klicken Sie auf die rote Nadel
im Hauptfenster oder auf die Synchronlinie im SpecJT-Fenster, schalten Freeze ein und
reduzieren Sie Tol auf 100 Hz und weniger. JT65 sucht dann nur noch im Bereich von Tol um
die gefundene Synchronlinie herum. Die aktuelle Lage dieser Synchronlinie wird im Feld
Freeze DF angezeigt.

Wenn Sie im JT65-Modus doppelt auf die Synchronlinie im Wasserfall oder die Spitze in der
roten Linie klicken, wird automatisch Freeze auf EIN und Tol auf 50Hz gesetzt , die
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Frequenzablage Freeze DF angezeigt und der Dekoder gestartet. Mit dieser Methode kénnen
Sie schnell mehrere Signale mit verschiedenen DF-Werten durchtasten. In der Skala des
Wasserfalls ist die aktuelle Lage von Freeze DF farbig markiert. Die griinen Linien zeigen den
Bereich der Bandbreite und die roten Linien die Lage der Kurzmeldungstdne an. Der griine
Balken markiert die Breite des mit Tol eingestellten Suchbereichs, die Nadel in seiner Mitte ist
der aktuelle Wert von Freeze DF.

Der JT65-Dekoder nutzt eine Mehrschichtprozedur. Eine nahere Beschreibung dieser Prozedur
finden Sie unter

http://pulsar.princeton.edu/~joe/K1JT/IT65.pdf

Falls der nachgiebig entscheidende Reed-Solomon-Dekoder kein Ergebnis liefert, wird eine
tiefere Suche (deeper search ) mit einem angepassten Filter vorgenommen. Dieser Dekoder
erzeugt eine Reihe von hypothetischen Nachrichten und kombiniert alle Rufzeichen in der
Datenbank mit einem CQ oder dem eigenen Rufzeichen. Alle Nachrichten werden so erzeugt,
als sollten Sie zusammen mit den Fehlerkorrektursymbolen (FEC) gesendet werden. Diese
Daten werden mit dem empfangenen Text auf eine mégliche Ubereinstimmung verglichen.
Wenn nur ein Zeichen nicht Ubereinstimmt, wird die Dekodierung verworfen. Sie kdénnen selbst
eine Liste mdglicher Rufzeichen anlegen. Voreingestellt ist die mitgelieferte
Rufzeichendatenbank CALL3.TXT mit tGber 4800 Rufzeichen, von denen bekannt ist, dass sie
sich aktiv auf den VHF/UHF-Bandern mit der Arbeit mit schwachen Signalen befassen.

Sie sollten versuchen, diese Liste auf dem neuesten Stand zu halten.
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Zusatzlich zu den Werten von DT and DF enthalt die Zeile mit dem dekodierten Text
Informationen zur relativen Amplitude der Synchronisation, dem durchschnittlichen Signal-zu-
Stor-Verhaltnis in dB (relative Rauschleistung bezogen auf eine Bandbreite von 2500 Hz) und
die Angabe W zur gemessenen Frequenzbreite des Synchronsignals in Hz. DaN Zeichen nach
W gibt an, welcher adéquate Pegel der Synchronisation erreicht wurde. Ein Stern * wird bei
einer normalen Nachricht angezeigt, ein Doppelkreuz # flir eine Nachricht, die einen OO0O-
Signalrapport enthélt. Ganz rechts stehen weitere zwei Zahlen. Die erste Zahl gibt an, ob der
Reed-Solomon-Dekoder erfolgreich war (1) oder ob er erfolglos war (0). Die zweite Zahl gibt
gibt die relaive Zuverlassigkeit der Dekodierung zwischen 0 und 10 an, die vom Deep-Search.-
Dekoder erzeugt wurde. Kurzmeldungen erzeugen diese Angaben nicht.

Wenn JT65 auf eine Sendung richtig synchronisiert hat, werden die spektralen Daten mehrerer
Durchgange zu einem ,.Durchschnittstext™ (average text) aufaddiert. So kdnnen Texte
dekodiert werden, auch wenn im einzelnen Durchgang keine giltige Information gewonnen
werden konnte. Dieser Text erscheint unter den Texten der einzelnen Durchlaufe im ,Average
Window".
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Der Deep Search decoder von JT65 hat systembedingt eine ,Grauzone"®, in der er eine
Ldsung findet, die mdglicherweise nicht ganz vertrauenswiirdig ist. In diesen Fallen gibt der
Dekoder zusatzlich ein Fragezeichen ? vor dem dekodierten Text aus und der Operator muss
schlussendlich entscheiden, ob er die Dekodierung akzeptiert oder verwirft.

Gehen Sie davon aus, dass sich aufgrund der mathematischen Struktur der Nachrichten der
empfangene Text nicht in einem oder ein paar Zeichen von der Original-Nachricht
unterscheidet, sondern dass ganz falsche Rufzeichen und Lokatoren erscheinen. Wenn Sie
genug Erfahrungen bei der Auswertung der graphischen Anzeigen und der ausgegebenen
Werte flir Sync, dB, DT, DF, W und die griinen, roten und blauen Kurven gewonnen haben
und dazu die Storsignale und Interferenzen mit anderen Signalen beurteilen kénnen, werden
Sie eher giltige von ungiiltigen Daten unterscheiden kdnnen. Ruft Sie eine offensichtlich
exotische Station an, warten Sie lieber auf den nachsten Durchgang und sehen Sie, ob das
gleiche Rufzeichen wieder erscheint. Zufallige Fehler wiederholen sich sehr selten.

Sie kdnnen mit zahlreichen Optionen den Dekodierprozess von JT65 ihren Wiinschen
entsprechend beeinflussen. Wenn Sie die Option Decode > JT65 > Only EME calls werden
zum Deep search nur Rufzeichen aus der Datenbank bereitgestellt, die den Zusatz EME
tragen. Unterriicken Sie mit der Option No Shorthands if Tx 1 die Dekodierung von
Kurzmeldungen, so lange Sie noch die erste TX-Meldung senden. Mit dem Menl Decode >
JT65 koénnen Sie die Optionen fiir den Deep Search Decoder vorgeben. Der erste Punkt
No Deep Search schaltet ihn definitiv ab. Die Einstellung Normal Deep Search schaltet den
Dekoder an, unterdrlickt aber eine Ausgabe bei einem Vertrauenswert von weniger als 3. Mit
der Option Aggressive Deep Search ist ein Vertrauenswert von 1 noch zugelassen. Mit der
letzten Option Include Average in Aggressive Deep Search schalten Sie die
Mittelwertbildung Giber mehrere Durchldufe ein. Wenn Sie einen Sked verabredet haben,
kdnnen Sie die Box Sked aktivieren. Ergebnisse des Deep Search Decoder werden dann
nicht ausgegeben, wenn sie nicht relevant fir das aktuelle QSO sind.

Die JT65-Nachrichten haben drei mdgliche Formate :

1. Zwei bis vier alphanumerische Felder mit spezifischem Inhalt, wie weiter unten
beschrieben

2. Beliebiger Text mit maximal 13 Zeichen
3. Kurzmeldungen (Special shorthand messages) : RO, RRR und 73

Die vier Felder einer Nachricht vom Typ 1 enthalten die beiden legalen Rufzeichen, wahlweise
den vierstelligen Lokator und einen optionalen Rapport OOO. Das erste Rufzeichen kann durch
CQ oder QRZ ersetzt werden. Erlaubt sind Rufzeichenzusatze wie eine Landerbezeichnung
oder ein Suffix, die durch einen Schragstrich / vom Hauptrufzeichen getrennt sind. Weiterhin
sind erlaubt ein Signalrapport in der Form —NIN oder R-NN (=Signalrapport in dB) und die
Betriebskiirzel RO, RRR und 73. Das Minuszeichen vor dem numerischen Rapport ist Pflicht
und NN darf zwischen O1 und 30 liegen. Bei mdglichen Missverstandnissen, wer den Rapport
sendet, sollte er durch das Rufzeichen der Gegenstation oder einem Teil davon erganzt
werden. Eine Liste der erlaubten Zusatzprefixe und Suffixe finden Sie auf Seite 31.
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Nachrichten fiir ein Minimal-JT65-QSO sehen so aus :

« CQ K1JT FN20

=  K1JT VK7MO QE37
« VK7MO K1JT FN20 OO0

= RO
« RRR

= 73

Im Pile-up kann das Verfahren weiter verkirzt werden, wenn der Rapport der gehdrten
Station gleich beim Anruf gesendet und das freundliche 73 weggelassen wird :

« VK7MO K1JT -24
=  K1JT VK7MO R-26
* VK7MO K1JT RRR

Als Beispiel flir korrekte Rufzeichenzusatze kénnen Sie diese Liste verwenden :

« CQ ZA/PA2CHR

«  CQRWI1AY/1

«  ZA/PA2CHR K1JT

«  K1JT ZA/PA2CHR 000
«  QRZ K1JT FN20

Die Kurzmeldungen von JT65 sind sehr leistungsfahig, weil sie bei Signalpegeln von 5dB unter
den Standardnachrichten dekodiert werden kdnnen. Sie kdnnen Sie leicht als zwei
umgetastete Téne heraushdéren oder im Wasserfall als zwei parallele Linien sehen. Wenn eine
Nachricht mit RO, RRR oder 73 beginnt, wird sie als Kurzmeldung gesendet. Wenn die
Nachricht, die Anforderungen Punkt 1 erflillt und CQ, QRZ, ein oder zwei Rufzeichen, Lokator
und/oder Rapport enthalt, wird sie gesendet wie eingegeben. Bei jedem anderen Eintrag wird
eine Nachricht nach Punkt 2 erzeugt und davon werden maximal 13 Zeichen gesendet, Die
aktuell gesendete Nachricht sehen Sie im Hauptfenster rechts unten. Eine Standardmeldung
(1) ist gelb, eine Kurzmeldung (3) ist blau und eine Text-Nachricht (2) rot hinterlegt.

cw

Die Sendeart CW von WSJT ist als Service fir die Nutzer vorgesehen, die EME-Kontakte in
CW mit Intervallen von 1, 2 oder 2,5 Minuten machen wollen. Das Programm sendet die EME-
Nachrichten mit einem Tempo von 15 WpM als 800Hz-Audioton und libernimmt die
Sende/Empfangssteuerung. Die Kodierung der empfangenen Signale muss der Operator selbst
Ubernehmen. Wahlen Sie die gewiinschte Periodendauer mit einem Links- oder Rechtsklick auf
eine der Tasten unten in der Mitte des Hauptfensters. Ublicherweise werden 1min-Perioden
auf 50 MHz, 1- oder 2-Minuten-Perioden auf 144 MHz und 2,5min-Perioden auf 432 MHz und
hoéher verwendet.
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Das Konsolenfenster

Das Konsolenfenster (console window) ist fiir die Startmeldungen und mdgliche
Diagnosemeldungen von WSJT vorgesehen. Das Startfenster sieht etwa so aus wie das unten
stehende Bild. Wenn Sie in Ihrem Rechner mehr als eine Soundkarte (oder ein USB-
Zusatzgerat (DM3ML)) haben, sehen Sie welche Schnittstellen flir WSJT zur Verfiigung stehen
und welche Ziffern Sie fir Audio In und Audio Out im Optionsfenster eintragen missen.
Hinweis DM3ML : Fur Eingang und Ausgang sind getrennte Ziffern einzutragen.

Console Window

€ WSJT6

2 8488 <Thu. 83 Aug 2886>
Ftl Flu.| B4 16:44: 58 2886 UTC

Input QOutput Device Hame
Channels C lmnnr 1“

a
a f
2 Microsoft nd Mapper - Output
SoundMAR Digital Audio

Input : Qutput: 2
ted Inpur' A Output: @
B for input, 2 for output.
unning normally.
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Astronomische Daten

Im JT65-Fenster ist ein blau hinterlegtes €\ actronomical data g@@
Fenster mit den Antennendaten fiir den

Mond, die Dopplershift und die zu Az El
erwartende Abschwachung (Degradation) :

zu sehen, Sie kdnnen mit einem Klick auf Moon: 75.40 -58.10
das Menl View > Astronomical data Moon/DX: 127.55 -1.30
weitere Daten in einem getrennten Fenster !

abrufen (Bild rechts). Die Daten enthalten Sun: 206.67 63.83
die Antennenrichtung fiir Azimut Az und Source: 317.66 -41.02

Elevation El zum Mond (Moon) und zur
Sonne (Sun). Daten flir eine weiteres

astronomisches Ziel (Source) Ihrer Wahl Doppler df/dt
kdnnen Sie unter dem Menlpunkt Setup ]

> Options mit den Werten fiir RA (right DX: 260 0.23
ascension) und DEC (declination) im Self: 221 0.99

Format hh:mm:ss und dd.dd. eingeben.
Die Werte fiir Az und El werden sowohl fiir

gen eiger:jen Sdtandort (Moon) als auch fir RA DEC
en Standort der Gegenstation L -

(Moon/DX)berechnet. Unter Doppler MOD”' 1938 -2663
wird die aktuelle Dopplershift in Hz und Source: 00:00 0.00

unter df/dt die Anderungsrate der
Dopplershift in Hz/Minute sowohl fiir die

eigene Station (Self) als auch die Freq: 144 Tsky: 580
Gegenstation (DX) ausgegeben. Diese ; iy,

Werte kénnen fir die Suche nach den MNR: 1.4 Dgrd' 4.3
eigenen Echos herangezogen werden. Die DPol: -15 SD: 16.35

Az /El-Werte werden in Grad und die
Werte flir RA und DEC in Stunden und
Minuten angegeben. Der Wert Tsky gibt die angenaherte galaktische Hintergrundtemperatur
fur die Antennenrichtung zum Mond bezogen auf die aktuelle Arbeitsfrequenz Freq an. MNR
steht fir die maximale Nichtreprozitat des EME-Pfades in dB hervorgerufen durch die spatiale
Polarisation. Dpol ist der spatiale Polarisationsoffset und Dgrd ist eine Abschatzung der
totalen Signalabschwachung relativ zum mdglichen Bestwert, wenn der Mond im Perigaum vor
einem kalten Bereich des Himmels steht. SD ist der Mondhalbmesser in Bogenminuten.

Rufzeichendatenbank

WSJT stellt als Service flir den Funkbetrieb die einfache Rufzeichendatenbank CALL3.TXT zur
Verfiigung. . Eine voreingestellte Datei wird zum Programm WSJT mitgeliefert. Sie kénnen
diese Datei aber aktualisieren und/oder sie Ihren Wiinschen anpassen. Die aktuelle Version
der Rufzeichendatenbank wird von DL8EBW betreut und ist von der Adresse
http://www.dI8ebw.de/DATABASE/database.html

abholbar.


http://www.dl8ebw.de/DATABASE/database.html
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Schriftarten

Sie kénnen die unter WSJT verwendeten Schriftarten, -groBen und —farben Ihren Wiinschen
anpassen. Die Einstellungen stehen unter Windows in der Datei wsjtrc.win oder unter Linux
und FreeBSD in der Datei wsjtrc. Die Datei enthalt diese Angaben :

*font: Arial 8
*Label*font: Arial B8
*Text*font: "Courier New" 9
*background: graygs
*Text*background: white
*Entry*background: white
*foreground: black
*Listbox*foreground: RoyalBlue

Sie kdnnen diese Datei mit einem Texteditor wie Notepad editieren. Wenn Sie die Anzeige
etwa gréBer machen wollen, @ndern Sie die Zeilenzahl in den ersten drei Zeilen auf 9,9, und
10. Sie sollten aber vor der Anderung eine Sicherheitskopie der Datei anlegen und sie u.U.
wieder zurlickholen.

Menus und der Schirm Setup > Options

Datei (File)

File Setup “iew Mode Decode

Open
Open next in directory
Decode remaining files in directory

Delete all * WAY files in RxANMAY

Erase ALL.TXT

Exit

Open: Liest und dekodiert eine friiher auf der Festplatte abgespeicherte WAV-Datei. Die Datei
muss ein Standardformat mit einem 8-oder 16-Bit monoauralem Format und einer Abtastrate
von 11025 Hz haben.

Open next in directory (F6): Holt die nachste Datei und dekodiert sie. Vorher muss die
Datei davor getffnet worden sein.

Decode remaining files in directory (Shift-F6): 6ffnet und dekodiert nacheinander alle
Dateien nach der zuerst gedffneten Datei
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Delete all *.WAV files in RxXWav: |0scht alle *.WAV-Dateien im RxWav-Unterverzeichnis
Erase ALL.TXT: I6scht die Protokolldatei ALL.TXT
Exit: beendet WSIT.

Fenster Setup > Options

%' Options Q@@

— Station parameters ————  — FSK441 UTEM message templates ————  — Miscellansous

Mycat  [eior e T oml| [vam | | orecwm [—

Grid Locator: [FN206i | sourcera: [

1D brnterval (m); |10 Resst defaults | Source DEC: I_
{| Frree Tx 1: [T 2o
awioi: o Tx 2 [56T %R %M %R%R
swioout o Tx 3 [R%R
Rade It fro Tx 4 [RRR
T |2

Distanceunit: & mi  km Tx & |CG! ol

My Call: Eigenes Rufzeichen eingeben
Grid Locator: Eigenen 6-stelligen Lokator eingeben

ID Interval (m): Zeitabstand der automatischen CW-Identifikation in Minuten. Wird eine 0
(Null) eingetragen, wird keine CW-Identifikation erzeugt.

PTT Port: in Windows : Geben Sie die COM-Schnittstelle an, mit der die PTT geschaltet wird
(DM3ML : verwendet wird das Signal RTS). Geben Sie bei Linux oder FreeBSD den
Geratenamen der seriellen oder parallelen Schnittstelle ein, z.B. /dev/ttySO0.

Audio In, Audio Out: Falls Sie mehr als eine Soundkarte haben, geben Sie die Nummern der
Ein- und Ausgange ein. Informieren Sie sich im_Konsolenfenster

Rate In: Tragen Sie hier die erste Zahl aus dem Hauptfenster unten links ein, wenn Sie sich
ausserhalb des Bereichs 0.9995 bis 1.0005 nach einer Stabilisierungszeit befindet (Korrektur
des Soundkartentaktes).

Rate Out: wie bei Rate In mit dem zweiten Wert in der Statuszeile unten links

Distance unit: Entfernungseinheit Meilen (miles) oder Kilometer innerhalb des Programms

Report/Grid: wahlen Sie ob bei FSK441 and JT6M entweder der Rapport oder der Lokator im
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voreingestellten Text verwendet werden soll.

NA/EU: wahlen Sie die voreingestellten Texte in der amerikanischen oder der europdischen
Version flir FSK441 und JT6M

Reset defaults: Vorbereitung der voreingestellten Texte flir FSK441 und JT6M messages. Die
Texte kénnen editiert werden.

Die Makros sind :

%M eigenes Rufzeichen (MyCall)

%T Rufzeichen der Gegenstation im Feld To radio

%R Signalrapport

%G Lokator vierstellig

%L Lokator 6-stellig

DXCC prefix: Sie konnen wahlweise in den JT65-Nachrichten einen zusatzlichen DX-Prefix
z.B. bei einer Expedition ausgeben.

Source RA, Source DEC: Geben hier die astronomischen Koordinaten eines ausgewahlten
Ziels ein. Das Programm berechnet die Antennenrichtung mit Az und El fir dieses Ziel. Die
Koordinaten sind im Format hh:mm:ss, dd.dd flir die Aszension (current right ascension) und
die Deklination (declination) einzugeben.

Andere Einstellungen (Other Setup Items)

File Setup “iew Mode Decode Save

Optionz

Toggle size of text window
Generste messages for test tones

Fd sets TxB
Double-click on callzign sets TxFirst
Genstdkisgs sets Txd

Ermble disgnostics

Toggle size of text window: Macht das Textfenster groBer oder kleiner

Generate messages for test tones: erzeugt spezielle Tx-Nachrichten mit festen Ténen auf
den vier FSK441 — Frequenzen (A=882, B=1323, C=1764, D=2205 Hz) oder auf 1000 und
2000 Hz. Sie kénnen die letzten zwei Nachrichten so spezifizieren, dass jede Audiofrequenz bis
hinauf zu 5000 Hz erzeugt wird.

F4 sets Tx6: wird diese Funktion aktiviert, 16scht die Taste F4 die Eintrage in den Feldern To
radio und Grid und schaltet auf den CQ-Text auf der Taste Tx6.
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Double-click on callsign sets Tx First: wird diese Funktion aktiviert, wird mit einem
Doppelklick auf ein Rufzeichen im Textfeld die Funktion TxFirst in Abhangigkeit von der
aktuellen Zeitlage der empfangenen Station entweder ein- oder abgeschaltet und damit die
Zeitlage der eigenen Sendung vorbereitet.

GenStdMsgs sets Tx1: wird diese Funktion aktiviert erzeugt ein Klick zur Vorbereitung der
Standardtexte auf die Taste GenStdMsgs auch einen entsprechenden Text im Feld Tx1.

Anzeigen (View)

Offnet ein gewiinschtes zweites Fenster

File Setup View Mode Decode

SpecdT
Astronomical data

Sendeart (Mode)

Wahlt die gewunschte Sendeart

File Setup “iew Mode Decode

FSk441
JTEM
JTESA
v JTESE
JTBSC
Y
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Dekodierung (Decode)

€ WSJT6 byK1JT

File Setup View Mode Decode Save Band Help

< [

’ Only EME c%

Mo Shorthands if Tx 1

Mo Deep Search
Marmal Deep Search

Agogressive Deep Search

14
FlelD Sync dB OT OF W v Include Average in Aggressive Deep Search

Auswahl der Optionen fir die Dekodierung unter FSK441 und JT65.

Sichern (Save)

S WSJT6 byKIJT Auswahl, welche Dateien nach

File Setup WView Mode Decode Save Band Help dem Dekodieren gesichert
werden sollen

| v Mone

Save decoded
Save if Auto On
Save all

Band

EETTRCTT .. s

Fle Setup View Mode Decode Save Band Hep  DoPplerberechnung und Log

50

v 144
222
432
1295
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Hilfe (Help)

$ WSJT6 byKIJTK

File Setup Wiew Mode Decode 5Save Band Help

Keyhoard shortcuts

Special mouse commands

What message to send?

Aysilable suffices and add-on prefizes
About WWSJT

Tastatur-Kurzrufe

S WSJT6 byKIIT
F1 List kevhoard shortcuts
Shift-F1  List special mouse commands F1Liste der Tastaturkurzrufe
CTRL-F1 About VWWSJT Shift-F1  Liste der Mauskommandos
F2 Options Strf-F1  Uber WSJT
F3 T Mute F20ptionen
F4 Clear "To Radio F3TX sperren
F5 VWhat message to send? F4Feld To Radio I6schen
FE F5Welche Nachricht senden ?

Opean J:g:‘t file in clirectory
Shift-FE Decode all wave vles in directory
F7 Set FSK441 moce
Shit-F7  Set JTEM mode

F6N&chste WAV-Datei holen
Shift-F6  Alle WAV-Dateien abspielen
F7FSK 441 einschalten

Shift-F7  JT6M einschalten
ie S ISR F8IT65A einschalten
Shift-F8 et JTaSB mode Shift-F8  JT65B einschalten
CTRL-F& Set JTGSC mode Strg-F8  JT65C einschalten
Shift-CTRL-F8 Set OV mode Sh+Strg+F8 CW einschalten
F10 Toggle focus between WWSJT screens F10 Von Schirm zu Schirm
Al-1 to Ak-E Tx1 to Tx6 schalten

Alt-A Toggle Auto OniOff ALT-1 bis 6 Tx1 bis Tx6 aktivieren
Al-D Decode ALT-A Auto ein/aus
AR-E Erase ALT-D Dekodieren
AR-F Togole Freeze ALT-E Léschen
AR Generate Standard Meszsages ALT-F Freeze ein/aus
ARl Include ALT-G Standdardtexte erzeugen
AR-L Lookugp ALT-I  Include (Spur einschliessen)
CTRL-L  Lookup, then Generate Standard Messages ALT-L  Lookup (Vorausschau)
AR-M Monitor Strg-L Lookup+Standardtexte
AR-O Tx Stop erzeugen
ALT-M Monitor ein

Al-P F

ol ALT-O TX anhalten
AR-G Log @S0 .

A ALT-P abspielen
Alt-5 Stop Monitoring or Decoding |
ARV Save Last ALT-Q QSO loggen
P Exchud ALT-S Monitor/Dekoder aus
5 S ALT-V  letzte Spur speichern

Al-Z Toggle Zap ALT-X  Exclude (Spur ausschliessen)
RightlLeft Arroww  Incresseidecrease Freeze DF ALT-Z Zap aus/ein
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Pfeil links/rechts Freete DF runter/hoch
Siehe auch hier

Spezielle Mauskommandos

[—=nY —=ual —a]

€ WSJT6 byKiJT = |OJIX]

Click on Action

Waterfall  FSK441UTEM: click to decode ping
JTES: Click to set DF for Freeze
Double-click to Freeze and Decode

Main screen,  FSK4414TEM: click to decode ping
graphics area  JTES: Click to set OF for Freeze
Double-click to Freeze and Decode

Main screen, Double-click puts callsign in Tx messages
text area Fight-double-click also setz Auto ON

Sync, Clip,  LeftRight click to incresseldecrease
Tal, ...

Ubersetzung von Eike, DM3ML

Klicke auf Aktion

Wasserfall : FSK441/]JT6M:klicke auf
einen Ping zur Dekodierung

JT65 : Klicke auf ein Signal, um DF auf
Freeze zu setzen. Klicke doppelt um
Freeze einzuschalten und zu dekodieren

Hauptfenster, grafischer Bereich :
FSK441/]JT6M : klicke zum Dekodieren auf
einen Ping. JT65: Klicke auf ein Signal um
DF auf Freeze zu setzen . Doppelklick >
Freeze + Dekodierung

Hauptfenster, Textbereich :
Doppelklick auf ein Rufzeichen setzt es in
das Feld To Radio und die vorbereiteten
Nachrichten. Mit einem Rechtsklick wird
AUTO eingeschaltet.

Syng, Clip, Tol u.a : mit Linksklick
groBer, mit Rechtsklick kleiner
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Welche Nachricht senden ?

=y

L

WSJT 6 byK1JT

To optimize your chances of completing & valid QS0 using WSJT,

use the follovwing standard procedures and *do not* exchange pettinent

information by other means (e.q., internet, telephone, | while the
@S0 is in progress]

FSk441 or JTEM: If you have received
... le==s than bath calls from the other station, =end both calls.
.- both callz, 2end both calls and your signal report
.. hath calls: and signal report, send R and yaour report.
- R pluz =ignal report, 2end RRE.
.. RRR, the QS0 iz complete. However, the other station may not

Know this, =0 t is convertional to send 73 to signify that you are done.

(Outsice of Morth America, the customary procedures for FSK441
and JTEM may be slightly different.)

JTES: K you have received
.. lezs than both calls, =end both calls and your grid locator.
.- both calls, =end both calls, your grid locator, and OO0,
... both calls and OO0, zend RO,
.. RO, send RRR.
. Hﬁﬂ the QSO is complete, However, the other station may not

know this, so it is conventional to send 73 to signify that yvou are done.

(Sending grid locators is convventional in JTES, but numetical signal
reports may be substituted )

Ubersetzung von Eike, DM3ML

DieserText entspricht den Ausfiihrungen zu den zu sendenden Texten bei FSK441/JT6M und

JT65.
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Erlaubte Suffixe und angehangte Prefixe

% WSJT6 byKI1JT

Supported Suffixes:
PONREBMHMEBTEN

Supported Add-Cn DRCC Prefixes:

14 15 34 386 3B8 383 3C 3C0 3D2 3D2C 3D2R 3DA 3V
I 3 3% 3B 3YP 40 4L 45 41 U 4y 4X s4 SB

SH SM SR ST 50U S5V SW SK 57 BW BY 7O 7P 7Q 7X BP

B2 BR 9A 9G 9H 9J 9K 9L 9M2 9ME 9N 909U 9y 9

gy A2 A3 A4 AS AR A7 AJ AP BSY BY BY9 BY C2 C3

C5 C8 C9 CE CEOX CEOY CEDZ CES CM CM CP CT CT3 CU
CX CYD Cy3 D2 D4 DE DL DU E3 E4 EA EAE EAS EAD

El EX EL EP ER ES ET EU EX EY EZ F FG FH FJ FK

FKC FM FO FOA FOC FOM FP FR FRG FRJ FRT FTSW FTSX
FTSZ P FY H4 H40 HA HB HBO HC HCE HH HI HK HKDA
HKOM HL HW HP HR HS HV HZ | IS IS0 J2 J3 J5 J6

JT B JA JDM JDO JT MY JE JY K KC4 KG4 KHO KH1

KH2 KH3 KH4 KH5 KHSK KHE KHT KHS KH3 KL KP1 KPF2 KP4
KPS LA LU LY LY LZ W MD M MJ MM MU WMA O4 OD OF %
OH OHO OJ0 Ok OM ON OX OY O P2 P4 PA PJ2 PJ7 PTOS

PY PYOF PYOT PZ R1F RIM S0 52 S5 S7 59 EM SP ST

S 5Y SV5 SvO0 SYA T2 TADTH T32T33 1577 T8 19
TATFTGTITO TJ THK TL TM TR TT TU TY TZ UA

LA2 A9 UK UM UR Y2 W3 Y4 V5 VB WT W8 WE YK YHIH

WHOM WHIC WHIOL WHOM WKON WVREW WYREX WP2E WPIM VP2V VRS
YPE WPED VP8 VPEG VPEH YPBO WPES VP9 VO VR VU VU4
WUT HE HF4 XT XU XwW XK9 XI YA YB YI YJ YK YL YN

YO NS YU YY YW0 ZI2 I3 ZIA IB IC4 ID7 ZD8 ID9 IF

IKIN ZW1S ZK2 ZIK3 ZIL ZLT ZIL8 I19 ZIP IS ISH

Optional prefix: FS

>>> siehe auch Ausfiihrungen zu erlaubten Suffixen und Prefixen
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Uber WSJT

% WSIT6 byK1JT
WSJT Version 5.9.5r236 , by K1JT

YWET iz & weak signal communications program.  supports
four operating modes:

1. FSkK441 - fast mode for meteor scatter

2.JTEM - optimized for meteor and lonospheric scatter on 50 MHz
3.JT65 - for EME and troposcatter

4. 0N - 15WPM Morse code, messages structured for EME

Copyright () 2001-2006 by Joseph H. Taylor, Jr., K1JT, with
contributions from additional authors. WSJT is Open Source
software, licensed under the GMNU General Public License (GPL).
Source code and programming information may be found at

bty Hedeveloper herlios defrojectsivsits,

Revision date: 2006-08-03 09:17:25 -0400 (Thu, 03 Aug 2008)

Dieser Text entspricht dem Einfihrungskapitel.

SpecJT Optionen

% SpecT byK1JT

Options Freg 1

v Mark TR boundaries
v Flatten spectra
v Mark JTES tones only if Freeze is checked

R wolume control
T= wohame control

Frequency axis
v JTB5 DF axis

FPalette 3

Mark T/R boundaries: flige horizontale Linien zur Anzeige der Startzeiten fir Empfang und
Senden bei JT65 ein .

Flatten spectra: fiihre eine Korrektur fiir den Durchlassbereich des Empféangers durch, bevor
das Wasserfallspektrum bei JT65 angezeigt wird.
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Mark JT65 tones only if Freeze is checked : Zeige die Lage der JT65-T6ne nur an, wenn
Freeze eingeschaltet ist.

RX/TX volume control : Einstellung der Soundkartenamplituden, Soundmixer von Windows
rufen

Frequency axis : die Frequenzachse ist in Hertz etwa von 200 bis 2200 Hz eingeteilt

JT65 DF axis : Die Frequenzachse ist relativ zur JT65-Bezugsfrequenz bei etwa 1270 Hz in
Hz von -1000 Hz bis +1000 Hz eingeteilt.

Alphabetische Liste der Steuerelemente auf den Schirmen

Hinweis : einige der Menlipunkte erscheinen nur bei bestimmten Sendearten

Add: Erganzt die Rufzeichendatenbank CALL3.TXT mit dem Rufzeichen aus dem Feld To
Radio und dem darunter eingetragenen Lokator. Ist die Station schon in der Datenbank
enthalte, werden Sie gefragt, ob die Information iberschrieben werden sollt .

AFC: aktiviert die automatische Frequenznachfiihrung im Dekodieralgorithmus von JT65
Auto: aktiviert die automatische PTT-Steuerung flir die 30s/60s-Sende- und Empfangperioden
Clear Avg: I6scht den Text im Average-Textfeld (Summenbildung liber mehrere Durchldufe)
und leert den Nachrichten-Akkumulator

Clip: steht normalerweise auf 0 (Null). Wird es erhoht, wird das empfangene Signal weniger
oder mehr geklippt, um die Effekte statischer Entladungen und anderer Stérungen zu
verringern

Decode: analysiert die zuletzt (!! (ML)) empfangene Audiospur oder gedffnete WAV-Datei. Sie
kdnnen Dekodierparameter verandern und die Dekodierung erneut starten.

Defaults: setzt die Werte fiir S, Sync, Clip und Tol auf die voreingestellten Parameter
zurtick

Dsec: justiert Ihre UTC-Uhr in Schritten von + 0.5 s zur manuellen Synchronisation mit der
UTC-Zeit oder dem Senderhythmus des Partners. Sie sollten aber besser Ihre Computeruhr
Uber das Internet synchronisieren und Dsec auf 0 (Null) stehen lassen.

Erase: |6scht die Daten im Textfeld und dem grafischen Display des Hautfensters

Exclude: entfernt die zuletzt empfangene Audiospur aus dem Nachrichten-Akkumulator-
Benutzen Sie diese Funktion, wenn das Programm offensichtlich falsch synchronisiert hat und
z.B. DT und DF weit neben den erwarteten Werten liegen. Die dekodierte Audiospur wird dann
nicht in den Nachrichten-Akkumulator aufgenommen.

F1: zeigt die Liste der Tastatur-Kurzrufe an

Shift-F1: zeigt die Liste der speziellen Mauskommandos an

F2: ruft den Schirm Options

F3: Sendesperre ein/aus (Tx mute)

F4: I6scht die Felder To radio und Grid

F5: ruft das Fenster mit den zu sendenden Nachrichten

F6: 6ffnet und dekodiert eine abgespeicherte WAV-Datei

F7: schaltet auf die Sendeart FSK441

Shift-F7: schaltet auf die Sendeart JT6M

F8: schaltet auf die Sendeart JT65A

Shift-F8: schaltet auf die Sendeart JT65B

CTRL-F8: schaltet auf die Sendeart JT65C

F10: schaltet zwischen den Schirmen Spec]T und WSJT-Hauptschirm hin und her
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Freeze: sucht nur nach Signalen inner halb der Toleranz £Tol Hz um die Frequenzlage
Freeze DF. Freeze DF kann mit den Links/Rechts-Pfeilen auf der Tastatur korrigiert werden.
Bei JT65 kann dieser Wert auch mit einem Klick auf die Spitze in der roten Kurve im
Hauptfenster oder auf die Synchronlinie im Wasserfall des SpecJT-Wasserfalls geandert
werden

Gen Std Msgs: erzeugt die Standardnachrichten entsprechend dem Standard fir die
gewahlte Sendeart

Include: auch wenn der Signalpegel unter =33 dB liegt und der flir Sync angezeigte Wert
unter der eingestellten Schwelle liegt, kdnnen Sie eine empfangene Audiospur per Hand in den
Nachrichten-Akkumulator aufnehmen lassen

Log QSO: das Rufzeichen im Feld To radio wird in einer einfachen Logdatei WSJT.LOG mit
Datum, Uhrzeit, Rufzeichen, Lokator, Band und Sendeart abgespeichert (DM3ML: Rapporte
werden nicht geloggt)

Lookup: sieht in der Datenbank CALL3.TXT fiir das in To radio eingetragene Rufteichen nach
dem Lokator. Falls es ihn nicht findet, tragen Sie aus der empfangenen Nachricht den Lokator
ein, um Entfernung, Azimut, Elevation und Dopplershift berechnen zu kdnnen.

Monitor: schaltet die Dekodierung des Empfangskanals ein. Sie kdnnen mit Tol = 400..600Hz
nach Signalen im Passband des Empfangers suchen und den Funkbetrieb im Kanal
mitschreiben.

NB: kappt kurze Stérimpulse im Empfangskanal, bevor die empfangenen Daten dekodiert
werden

S: setzt den minimalen Signalpegel in dB flir einen Ping, Gber dem er flir eine Dekodierung
liegen muss

Save: speichert die zuletzt empfangene Audiospur ab

Sh Msg: gibt die Ausgabe von Kurzmeldungen (shorthand messages) unter FSK441 frei
Sked : aktivieren Sie dieses Feld, wenn Sie sich mit einer Station verabredet haben und keine
Ergebnisse des Deep Search Decoders sehen wollen, die nicht fir Ihr QSO relevant sind
Stop: beendet die Arbeit des Monitors

Sync: setzt die Synchronisierschwelle fiir den JT65-Dekoder (voreingestellt auf 1)

Tol: setzt die Toleranz des Decoders flir Frequenzabweichungen in Hz

Tx1-Tx6 : sendet die vorbereiteten Nachrichten Tx1 bis Tx6

Tx First: aktivieren Sie dieses Feld, wenn Sie jeweils zu den geraden Minuten senden wollen.
Schalten Sie die Option ab, wenn Ihre Gegenstation zu den geraden Minuten sendet oder
gesendet hat.

Tx Stop: stoppt eine Sendung unmittelbar und schaltet Auto auf Aus

Zap : unterdriickt schmale Stdrsignale mit nahezu konstanter Amplitude, bevor das Signal
dekodiert wird

Felder im Hauptschirm

Average Text: zeigt aufsummierte Audiospuren in der Sendeart JT65

Decoded Text: zeigt die dekodierten Texte des/der letzten Durchgangs/Durchgange mit
zusatzlichen Informationen an

Grid: nach einem erfolgreichen Lookup wird der Lokator der Gegenstation aus dem Feld To
radio sechsstellig in dieses Feld eingetragen. Wird das Rufzeichen der Gegenstation nicht in
der Datenbank gefunden, kénnen Sie den Lokator 4- oder 6-stellig von Hand eingeben. Ist er
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nur vierstellig bekannt, geben Sie am Ende eine weiteren Zwischenraum ein.

Report: gilt fir FSK441 und JT6M. tragen Sie den Signalrapport fiir die Gegenstation ein und
klicken Sie dann auf die Taste GenStdMsgs.

Status Bar: Untere Leiste des WSJT-Fensters, enthadlt die Soundkartenabtastraten, die
Sendeart, die eingefrorene Frequenzablage (Freeze DF), den RX-Rauschpegel, die
Sendeperiode , den Sendestatus und die aktuell gesendete Nachricht.

Moon: aktuelle Antennenrichtung zum Mond mit Azimut und Elevation flir Ihren Standort, die
2-Weg-EME-Dopplershift zwischen Threm Standort und dem Standort der Gegenstation
(Lokator eingeben !) und die Signalabschwachung in dB flir das angewahlte Band.

To radio: Rufzeichen der Gegenstation, die gerufen wird. Der hier eingegebene Text wird als
Anfang des Namens der aufgezeichneten Dateien verwendet.
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Anhang A: WSJT-Protokoll-Spezifikation

FSK441

FSK441 verwendet eine MFSK-Tastung mit vier Ténen und einer Datenrate von 441 Baud. Die
Frequenzen der getasteten Audiotone sind 882, 1323, 1764 und 2205 Hz. Jedes kodierte
Zeichen besteht aus drei Tonintervallen und hat daher eine Lange von 3/441 Sekunden (etwa
2,3 ms) flr die Aussendung. Der FSK441-Zeichensatz enthalt 43 Zeichen nach der unten
stehenden Tabelle :

FSK441 character codes

1 001 H 120
2 002 I T2
3 003 J 122
4 010 K 123
5 LT L 130
& 012 M 13k
7 P N 132
8 020 0 1323
9 D21 P 200
022 Q 201
2 023 E 202
? X310 S 203
/ 031 T 2110
¥ D32 U 93 i B
<space> (033 v il i
5 100 W 213
i 101 X 220
B 102 ' 221
C 103 0 P
D 110 E 230
E 112 Z 231
G 113

Die vier Tone sind mit den Ziffern 0—3 bezeichnet und gehéren zu den Frequenzen 882, 1323,
1764 und 2205 Hz. Der Buchstabe T zum Beispiel mit der Kodierung 210 wird mit der Tonfolge
1764-1323-882 Hz gesendet. Beachten Sie bitte dass der Zwischenraum (space) die Kodierung
033 hat und dass generell kein Zeichen mit dem hdchsten Ton (3) beginnt. Jede gesendete

Nachricht enthalt mindestens einen Zwischenraum. Der Dekodieralgorithmus kann daraus eine
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zuverlassige Synchronisation aus dem Nachrichteninhalt selbst ableiten ohne dariber hinaus
zusatzliche Zeichen (overhead) zu benétigen. Diese Kodierungsstrategie ist eins der
Geheimnisse fir die hohe Effektivitat von FSK441 fir die Kommunikation tber Meteorscatter.
Die vier mdglichen Ein-Ton-Codes 000, 111, 222 und 333 sind flir die Kurzmeldungen
(shorthand messages) reserviert. Wenn Sie verwendet werden, wird ein reiner Ein-
Frequenzton gesendet, diese Pings kdnnen Sie sogar mit dem Ohr erkennen. Als
Kurzmeldungen sind reserviert “R26”, "R27", "RRR” und “73". Diese Meldungen werden in der
Regel nach Austausch der Rufzeichen gesendet. Sie sollten in der IARU-Region 1 wegen der
hohen Aktivitat dort nicht allein verwendet, sondern durch Rufzeichen erganzt werden.

JT6M

JT6M verwendet eine Frequenzumtastung mit 44 Tonen. 43 Tone werden flr das Alphabet
und einer zur Synchronisierung verwendet. Es wird der gleiche alphanumerische Zeichensatz
wie bei FSK441 verwendet. Als Synchronton wird die Frequenz 1102500/1024 = 1076.66 Hz
verwendet. Die anderen 43 mdglichen Téne werden im Abstand von 11025/512 = 21.53 HZ
bis hinauf zu 2002.59 Hz erzeugt. Die gesendeten Symbole werden mit einer Rate von 21.53
Baud getastet. Jeder Ton dauert also 1/21.53 = 0.04644 Sekunden. Jedes dritte Zeichen ist
ein Synchronton und auf einen Synchronton folgenden zwei kodierte Zeichen. Daraus ergibt
sich eine Netto-Datenrate von (2/3)*21.53 = 14.4 Zeichen pro Sekunde. Das gesendete Signal
hort sich an wie Piccolo-Musik.

JT65

Eine detaillierte Beschreibung des JT65-Protokolls finden Sie im ARRL-Technik-Journal QEX for
vom September-October, 2005 (siehe http://pulsar.princeton.edu/~joe/K1JT/JT65.pdf). Kurz
zusammengefasst verwendet JT65 Sende-/Empfangsperioden von 60 Sekunden und sorgfaltig
strukturierte Nachrichten. Standardnachrichten werden komprimiert, so dass fir zwei
Rufzeichen und einen Lokator 71 Bits benétigt werden (Typ 1). Das 72. Bit wird verwendet zur
Kennzeichnung, dass es sich um eine Nachricht aus frei wahlbarem Text (Typ 2) mit maximal
13 Zeichen anstelle von zwei Rufzeichen und Lokator handelt. Spezielle Formate erlauben eine
andere Information z.B. eine Rufzeichen mit Prefix wie ZA/PA2CHR oder numerische
Signalrapporte in dB anstelle des Lokators. Das Ziel der Kodierung ist es, die tblichen
Nachrichten in EME-QSOs auf eine feste Anzahl von Bits zu komprimieren. Nach der
Kompression konvertiert ein (63,12)-Reed-Solomon-Kode mit Fehlerkorrektur die 72 Bit der
Nutzernachricht in 63 sechs-Bit-Kanal-Symbole.

JT65 bendtigt eine enge Synchronisation beziiglich Zeit und Frequenz zwischen Sender und
Empfanger. Jede Sendung wird in 126 zusammenhangende Zeitintervalle oder Symbole
eingeteilt. Jedes Symbol hat eine Lange von 4096/11025 = 0.372 s. Innerhalb jeden Intervalls
ist die Wellenform von konstanter Amplitude und sinusférmig auf einer der 65 vordefinierten
Frequenzen. Der Wechsel von einer Frequenz zur anderen erfolgt ohne Phasensprung. In der
Mitte des Kanals werden die Symbole einem Pseudo-Random-Synchronvektor zugeordnet, der
mit den enkodierten Informationssymbolen verschachtelt wird, Der Synchronvektor erlaubt es,
relative Zeit- und Frequenzverschiebungen zwischen Sender und Empfanger zu korrigieren.
Eine Sendung beginnt nominell bei ¢ = 1 s nach dem Start des Intervalls zur geraden oder
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ungeraden UTC-Minute und endet bei t = 47.8 s. Der Synchronton wird auf der Frequenz
1025*472/4096 = 1270.5 Hz gesendet und ist dann aktiv, wenn in der folgenden Pseudo-
Random-Folge eine ,1’ zu sehen ist.

100110001111110101000101100100011100111101101111000110101011001
101010100100000011000000011010010110101010011001001000011111111

Die kodierte Nutzinformation wird in den 63 Intervallen, in denen kein Synchronton erzeugt
wird, gesendet. Jedes Kanalsymbol erzeugt einen Ton mit der Frequenz 1275.8 + 2.6917 N*m
Hz. Dabei ist N der Wert des 6-Bit-Symbols mit 0 < N < 63 und mist 1, 2 oder 4 flr die JT65-
Untersendearten A, B, oder C. Der Signalrapport "*O00"” wird durch Vertauschung der Sync-
Ton und der Datenposition gesendet. Die Kurzmeldungen verzichten auf den Synchronvektor
und verwenden Intervalle von 1.486 s (16,384 samples) mit alternativen Ténen. Die niedrigste
Frequenz ist immer 1270.5 Hz, die gleiche wie der Synchronton . Der Frequenzabstand des
zweiten Tones ergibt sich aus dem Abstand von 26.92 n*m Hz mit n = 2, 3, 4 flr die
Mitteilungen RO, RRR und 73 und m = 1, 2 oder 4 fiir JT65A,B,C.

Anmerkung DM3ML : Der Synchronton 1270 Hz ist der Mittelpunkt der Skala im Wasserfall. Im
Spektrum ist der Synchronton die niedrigste gesendete Frequenz und wegen seiner Haufung
als nahezu durchgehende Linie links im Spektrum zu sehen. Die Kurzmeldungen erscheinen als
parallele Linien. Eine JT65-Nachricht dauert knapp 47 Sekunden. Wenn Sie nicht ganz am
Anfang bereits auf Empfang sind, wird die aktuelle Meldung nicht dekodiert. Achten Sie daher
darauf, dass ihre Uhr genauer als eine Sekunde synchronisiert ist.

Anhang B: Astronomische Berechnungen

WSIJT flihrt eine Reihe an astronomischen Berechnungen aus, um die Antennendaten fiir Mond
und Sonne, die Dopplershift der EME-Signale, die Hintergrundtemperatur des Himmels und
andere Daten zu bestimmen. Sie sollten einiges Uber die Natur und die Genauigkeit dieser
Berechnungen wissen.

Der Stand der Technik zur Bestimmung dreidimensionaler Orte auf der Sonne, dem Mond und
den Planeten ist ein numerisches Modell, dass vom Jet Propulsion Laboratory ausgearbeitet
wurde. Das Modell wurde numerisch integriert und liefert tabellarischen Date, die mit sehr
hoher Genauigkeit interpoliert werden kénnen. Zum Beispiel kdnnen die himmlischen Daten
von Mond oder von Planeten fiir eine bestimmte Zeit mit einer Genauigkeit von etwa
0.0000003 Grad bestimmt werden. Diese Ephemeridentabellen und Interpolationsroutinen
hatten relativ leicht nach WSJT Gibernommen werden kdnnen. Sie liefern aber wesentlich
genauere Daten als sie flir WSJT benétigt werden. WSJT verwendet daher Berechnungen in
geschlossener Form mit einer begrenzten Anzahl an harmonischen Termen, erreicht aber
trotzdem eine ausreichend hohe Genauigkeit.

Die genauen Algorithmen fiir die Berechnung der Position von Sonne und Mond wurden von
Van Flandern und Pulkkinen (Astrophysical Journal Supplement Series, 44, 391-411, 1979)
entwickelt. Die Erweiterung der Serien brachten eine Erhéhung der Genauigkeit um 0,02 und
0,04 Grad fir die Positionen von Sonne und Mond und sie werden auch fiir die nachsten
tausend Jahre gelten. Bei diesem Genauigkeitspegel kénnen die Effekte von Nutation und
Aberrration vernachlassigt werden, wie auch die kleineren planetaren Perturbationen.
Eingeschlossen sind aber die Perturbationen, die Mond, Jupiter, Saturn und Uranus betreffen.
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Die Ephemeriden-Zeit und die Universal-Zeit werden als gleich angenommen und die
gelegentlichen Zeitsprungsekunden werden ignoriert. Insgesamt wird ein ausreichend hoher
Genauigkeitspegel erreicht.

Die fir die Sonne angezeigten Koordinaten sind geozentrisch. Da der Mond wesentlich néher
ist, ist seine Tagesparallaxe wichtig. Daher werden die Koordinaten topozentrisch flir Ihren
Standort angegeben. Die jeweils angegebene Elevation fir Sonne und Mond bezieht sich auf
die Mitte der Scheibe.

Um die Genauigkeit der vorhergesagten Dopplershift der EME-Signale zu erhéhen, wurde eine
gréBere Anzahl an Termen fir die Serienerweiterung in die Berechnung des Mondabstandes
einbezogen. WSJT bericksichtigt die Erdabplattung bezogen auf Ihren Standort relativ zum
Erdmittelpunkt. Die Genauigkeit der Berechnung der Dopplershift ist besser als 1 Hz auf 144
MHz. Sie wurde durch den direkten Vergleich mit den JPL-Ephemeriden bestatigt.

Die von WSJT angegebenen Himmeltemperaturen werden der 408 MHz-Himmelskarte von
Haslam et al. (Astronomy and Astrophysics Supplement Series, 47, 1, 1982) entnommen und
relativ zur Frequenz auf die (—2.6)-Leistung skaliert. Die genannte Karte hat eine Auflésung
von etwa 1° und ist damit genauer als der Offnungswinkel der meisten EME-Antennen. Ihre
Antenne kann daher u.U. Hotspots noch erfassen und die angegebenen
Temperaturunterschiede mehr oder weniger glatten. Selbst wenn Sie Ihre Nebenkeulen und
die Bodenreflektionen kennen, ist es unwahrscheinlich, dass genauere Himmeltemperaturen
einen Einfluss auf die praktische Arbeit haben.

Anhang C: Quellen-Code

Ende 2005 wurde WSJT als Open-Source-Programm unter GNU General Public License (GPL)
verdffentlicht. Sie erhalten den Quellencode und Instruktionen zum Kompilieren des
Programms unter der Adresse

http://developer.berlios.de/projects/wsijt

Um diesen Quellcode effektiv nutzen zu kénnen, miissen Sie zusatzlich eine Reihe von Open-
Source-Paketen installieren, die Subversion, Python, Tcl/Tk, gcc, g77 und g95 (oder gfortran)
enthalten. Sie finden einige Hilfsdateien, wenn Sie das Material abholen.

Nutzerbeitrage zur Entwicklung von WSJT sind ausdriicklich erwlinscht. Verwenden Sie zur
Kommunikation mit dem Entwicklerteam die Email-Adresse

wsjt-devel@lists.berlios.de
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